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BN2-20 Training Outline
● BN2-20 Overview

● Policies, Safety & Materials

● Loading and Setting up Material the BN2-20

● Cutting Types and Pressures

● Setting up A Sticker File in Versaworks



● The BN2-20 is an eco solvent ink printer that can print on up to 20” wide material.
● It can automatically cut your printed items out (or not) as needed.
● It can print in white ink on matte and gloss paper, adhesive vinyl, metallic and holographic media, 

static cling material, heat transfer materials, and others. Not all inks and materials are covered in 
this introduction class. 

BN2-20 Introduction



Policies, Safety & Materials



Guidelines and Policies
● Sign the Makersmiths Waiver Form - This can be done at the iPad in the Leesburg classroom or 

the Purcellville Green Room
● The BN2-20 is a Red Tool – Red tools require safety training on a specific machine to operate 

unsupervised for safety and to prevent damage to the machine. 
● Schedule Your Time on the Printer – Login to Makersmith.org. Go to Reservations > UV Printer 

and BN2-20 Reservations and fill out the reservation form
○ Limits: 2 hours per day/10 hours per week
○ The UV printer and the BN2-20 can both be printed to simultaneously but please confirm with 

the other person if there is interest in sharing the computer between the machines because it’s 
not easy to have two using it at once. 

https://www.makersmiths.org/reservations/uv-printer-bn2-20
https://www.makersmiths.org/reservations/uv-printer-bn2-20


Guidelines and Policies
● Machine Cost Sharing

○ The costs for the machine are based on the cost of ink and media.  You can pay for these 
items using the Square terminal to the right of the machine.

○ There is no hourly/time charge to use the printer, just cost sharing for printing.

Material/Media Cost Sharing Measurement Price

BN2-20: Print+MS Media+MS Laminate Per Foot $5.00

BN2-20: Print+BYO Media Fee+MS Laminate Per Foot $3.00

BN2-20: Print+BYO Media+ BYO Laminate Per Foot $2.00

BN2-20: MS Laminate Fee Per Foot $1.00

BN2-20: Print+MS Media Per Foot $4.00



● You are more likely to hurt the machine than the machine to hurt you. 
● The only sharp part is the blade that cuts the paper and unless you have been specifically trained to 

do so, you won’t need to change this.  
● The printer carriage may move from side to side when the light on the power button is not solid blue.
● The machine will not operate if the acrylic window on the front of the machine is not in the down 

position/covering the print area.  

BN2-20 Safety Review



BN2-20 Material Types
● 3651M or 3651G Oracal (or Oraguard) Brand - Standard vinyl we use in Red Tool classes.  ‘M’ 

stands for Matte and ‘G’ stands for Gloss.
● Laminate is used over top of printed materials to make your project more scratch and UV resistant.
● Other materials such as clear, static cling, holographic, heat transfer, banner, and other materials 

are taught in the Advanced Class.



Getting to Know the BN2-20



Parts of the BN2-20

Media roller.  Removable 
to change the media or 
when you’re running an 

already cut sheet 
through.

Status Light
Blue=Ready

Yellow = 
Processing
Red = Error

Acrylic protection 
cover.  Machine 

won’t print unless 
this is closed.

Lever to secure 
and release 

media.

Only open the 
door if you are 
trained to clean 

the machine.

Only open the 
door if you are 
trained to clean 

the machine.

Blade and print head 
are inside the flap.  

Do not touch unless 
trained



Loading Material into the BN2-20

● Lift the feed lever handle on the front of the machine to open the feed mechanism.
● The metal flap with a black arrow on each side will pop down. 
● Lift the acrylic screen so that it is up and out of the way.
● Put your media on the roll, removing other media if necessary.  The media should be coming out 

the underside of the roller.
● If you loaded the media on the roller correctly, you will be able to see the printed media brand 

and type information on the backside of the roll as you feed it into the machine.



Loading Material into the BN2-20

● Push the media up into the machine, following the arrows, making sure the media is underneath 
the foot clips on both sides.

● Feed the media up and through the area where the printheads are.
● Feed the media under the black feet/media clamps on the left and right sides. There is a slit in 

both feet that hold down the media.  Be sure you see the media through each of those slits.
● Keeping the media as straight as possible by aligning it to the first ridge on the machine, the one 

with the small black rectangle on the right side. The sensor will beep when the media has been 
loaded far enough in.

● When lined up and under the rollers, pull down on the feed lever handle to lock the media in 
place.



Setting Up the Media
● Open the Roland DG Connect Hub Application.  
● Press the icon “BN2” in the lower left of the Connect Hub screen to open the BN2 Utility.
● If no media is setup, the BN2 Utility will say “Load media” at the top of the utility.
● In the BN2-20 utility panel, press “Setup” in the lower left corner. 



Setting Up the Media
● Select your media type.
● For the class, we will be selecting the Oraguard 3651M or 3651G for the first print. ‘M’ stands for 

matte, while ‘G’ stands for gloss.  (We will later select OrcalPlusLaminate after we laminate the 
vinyl once printed.)

● Press OK
● Press OK on the next screen.



Setting Up the Media
● The machine will now try to finish loading the media by checking to make sure that the paper is 

loaded far enough in and lined up correctly.  Once the material is loaded correctly, the message 
at the top of the BN2 utility will change from “Load Media” to “Output Possible”.  If setup fails, lift 
the lever, move the material further forward towards you in the machine, and run the Setup 
process again.  



Cut Types
● There are a few types of cuts to keep in mind when preparing your project:

○ Die-cut: A die-cut is usually done with a press and a sharp steel cutter, but the same 
concept can be done on the BN2-20. This type of cut follows the exact outer shape of your 
sticker and cuts all the way through giving you a clean, ready-to-use sticker with no extra 
material around it. You would use the “PerfCutContour” spot color to do a die cut on the 
BN2-20.  This leaves small tabs so the material stays in place after being cut out. These 
can be regular or irregular shapes.

○ Kiss cut: A kiss-cut only cuts through the top sticker layer (or laminate and sticker layer) 
while the backing stays intact, so you get an easier to peel sticker with some extra backing 
paper space around it. You would use the “CutContour” spot color on the BN2-20 with the 
pressure set to only cut through the top material.  These can be regular or irregular shapes.

○ Through cuts: As opposed to die cutting that only cuts around the outside of the sticker, 
this cuts all the way through the material, including inside parts of the design, which lets you 
remove sections and play with negative space.You would use the “PerfCutContour” spot 
color to do through cuts on the BN2-20 so that the sticker has small tabs and stays in place 
after being cut out. These can be regular or irregular shapes, but note that cutting out small 
inside parts from your sticker may or may not work well depending on the sharpness of the 
corners.



Cut Pressures
● The thickness of your material matters when printing and cutting out a sticker.  This applies to 

both the sticker material and any laminate applied.  Makersmiths has standardized on a set of 
materials and the class is taught with these in mind.  If you want to use other materials, you need 
to work with the steward to set the machine up correctly.

● The Makersmiths provided cut pressure settings are provided on magnets on the side of the 
BN2-20.

● For the purposes of the class, the “CutContour” pressure settings are to do Kiss Cuts and the 
“PerfCutContour” settings are used to do Die/Through Cuts with tabs to hold the sticker in place 
after cutting.  



Class Project
● For this class, we will print a set of stickers.
● You will load and setup the Oraguard material in the machine using the BN2-20 application.
● You will load, setup and print a row of stickers through Versaworks.
● You will laminate the sticker.
● You will reload the Oraguard + Laminate into the machine.
● You will load, setup and cut the stickers through Versaworks.



Setting Up the File in Versaworks
● Open Versaworks
● Click the BN2-20 printer at the top of the screen.  It should say “Ready to Print” under “BN2-20”
●
●
●
●
●
● Select Queue A then press the plus button or drag your file into the BN2-20 print queue A.  

● Be sure to add it to the BN2-20 queue, NOT the LEF2-200 (UV Printer)



Setting Up the File in Versaworks
● Double click the file you loaded and you will see this screen to setup your file.



Setting Up the File in Versaworks
● On the left side menu, press “Clip and Tile”.  
● This will show your sticker with CutContour and PerfCutContour lines if you set them up correctly.  

If it is setup incorrectly, you will see solid filled areas around your sticker.  If it is set up correctly, 
you will see dotted lines as in the image below.  The example below does not have a Kiss 
Cut/CutContour, only a Through Cut/PerfCutContour circle around the image .



Setting Up the File in Versaworks
Go to the “Layout” tab on the left

● Press the “Get Media Width” button.
● Check “Tile Spacing” on the Layout tab.  The default Tile 

Spacing is “Equal X and Y Spacing” and should be set to 
0.16”.  This is the distance around the outside rectangle 
of your artwork between each sticker.  Use this setting if 
you do not have added spacing around the outside of 
your artwork in the original file.

● If you added white space around your original artwork, 
you can reduce the spacing value so as not to add more 
than needed.

● In the “Position” section, tick the box for “Center on 
Media”

● Change the quantity to however many you want to print.  
It’s suggested to always increase the quantity to print at 
least one full row, otherwise you’re just wasting vinyl 
material.

● You can change the Orientation if needed to get more 
stickers on a row.



Setting Up the File in Versaworks
Go to the “Quality” tab

● Change the Media Type to 
“Generic Vinyl” if you are using the 
standard Makersmiths provided 
Oraguard (or Orcal) vinyl.

● You will usually change the Print 
Quality to High Quality, but 
depending on your project you 
may not need to.



Setting Up the File in Versaworks
Go to the “Mark” tab.

● For the class, you are going to Print first, 
laminate, then cut so you MUST tick the 
box next to “Crop Marks (Print&Cut 
Alignment)”.  This adds marks to your 
print so that the machine can perfectly 
realign the the paper after you’ve 
removed it and laminated it. 

● If you are printing and cutting at the same 
time, or not cutting at all, you don’t need 
to add the crop marks and can skip this 
step.



Setting Up the File in Versaworks
Go to the “Cut Controls” menu on the 
left hand side

● For this class, you will first Print 
Only, because we are going to add 
laminate. Choose “Print Only” in 
the Operation Mode. This is 
because you will later run a “Cut 
Only” process.

● For future projects, if you are going 
to print and cut at the same time 
(no laminate) choose “Print & Cut” 
in the Operation Mode, then set 
the pressure settings according to 
the settings printed on magnets on 
the side of the BN2-20.

Press OK in the bottom right corner to 
exit the file setup dialog.



Setting Up the File in Versaworks
● Right click your project in Versaworks, got to Print, and press Print.  This will print the crop marks 

and your stickers.



Cutting the Sheet
● When your print is done, go back to the BN2 Utility.
● If you are adding laminate, press the Move button and move the sheet down 100mm. This is the 

“down” direction.
● Press Cancel to go back to the main screen, then press the Sheet Cutting button.  This will move 

the print a further 75mm and then cut the paper.
● If you are not laminating your project, there are no further steps.



Laminating
● Let the ink dry a minute or two before putting the laminate on it.
● Cut enough length of laminate to cover both sets of registration marks. 
● Fold down a 1-2 in section of the backing to expose 1-2in of laminate.
● Be aware that any dirt or fuzz that may grab onto the front of your stickers before laminating will 

end up on your sticker.
● Line up the top of the laminate with the top of the printed sticker sheet.
● Start by applying the laminate on the top center of the sticker paper. Press a small section of 

laminate onto the sticker material.  Slowly move from the center out to the sides with a plastic 
squeegee, ensuring that the 1-2 in of laminate is straight with the top of the sticker paper.

● Insert the top 1-2in section of the laminate and sticker paper into the cold roller. As you turn the 
handle to feed both into the roller, slowly pull back the laminate backing.  Be careful and 
consistent, go slow so you don’t crease the laminate.

● Run through the laminator a few times after application
● Trim excess laminate on the side of your sticker sheet if larger than 1/8in



Load Laminated Material
● After your project is laminated, you have to reload the printed material, setup the material in the 

BN2-20 Utility, then setup to cut in Versaworks.
● It is important that you DO NOT change any size, quantity or spacing options in Versaworks.  You 

will ONLY change the Operation Mode and cut pressure settings. 
● Lift the feed lever handle on the front of the machine to open the feed mechanism.
● Lift the acrylic screen so that it is up and out of the way.
● Remove the roll media.
● Load your printed and laminated material as you did for the roll.



Load Laminated Material
● The registration mark with the rectangle is the top left and will be the first sensor area checked.  If 

you see two circles instead of 2 circles and one rectangle, it’s upside down.
● Line up the registration marks with the blade carriage. 
● When lined up and under the black feet/media clamps, with the registration marks in line with the 

blade carriage, pull down on the feed lever handle to lock the media in place.



Setup the Material
● Open the BN2 Utility, press Setup, and select OracalPlusLaminate.  If you have a different 

combination of paper and laminate for a project outside of this class, choose that combination.
● The machine will go through its setup process and “Load Media” at the top of the BN2-20 Utility 

will change to “Output Possible”.
● If setup fails, lift the lever, adjust the paper so that it is a square to the machine as possible and 

the blade carriage is lined up with the center of the crop marks, then go through Setup and select 
your material again.



Setup to Cut in Versaworks
● Open Versaworks if not already open.  Open your project.
● Go to the “Cut Controls” tab, change the Operation Mode to 

“Cut Only”
● Adjust the pressure settings in the “Conditions for Cutting 

Perforated Lines” section according to the settings printed on 
magnets on the side of the BN2-20.  You need to use the 
settings that include laminate for the class project.

● Press OK in the bottom right corner to return to the main 
Versaworks screen.

● Right click your project in Versaworks and press Print.  Even 
though you are pressing Print, it will only cut if you set the 
Operation Mode correctly above. 

● The BN2-20 will first check the crop marks top AND bottom. 
It will move the paper very quickly, be sure it is able to move 
freely. Getting stuck can damage the rollers.

● If the crop mark check fails, it will cancel the output. Lift the 
lever, realign to make sure the paper is square to the 
machine and the crop marks are aligned with the blade.  

● Lower the lever and press Print again.



Setup to Cut in Versaworks
● If you see a yield icon and nothing happening, You’ve forgotten to setup your Material in the 

BN2-20 Utility.
● For the class, your project will now cut through the laminate and sticker with a Kiss Cut and a 

Through Cut.
● When your print is done, go back to the BN2 Utility.
● Press the Sheet Cutting button.  This will move the print a further 75mm and then cut the paper.



BN2-20 Pre-Start Checklist
❏ WIP



Additional Notes
● Do not print more than about 100 2”x2” stickers at a time for each set of registration marks. The 

larger the number of stickers, the harder it is to line up the marks and the higher chance of print 
failure. 

● You CAN print multiple different stickers together in one job.  This will be covered in the Advanced 
Class.  It’s not recommended to laminate a sheet longer than 4 feet due to the difficulty in getting it 
all lined up.

● Different Kiss Cut settings can be added in the Setup Utility for materials other than those used in 
the basic class.  Learning to do this is covered in the Advanced Class. Please do not change the 
standard settings for standard materials.

● If the blade seems like it’s not cutting well, you can change out the whole blade carriage.  DO NOT 
twist the blade as it changes the height and is difficult to set.

● Remember the blade is very SHARP
● If you need to stop the machine you can pause it from the Setup Utility software.
● If you need to “Emergency stop” the machine, lift the front acrylic panel.  Follow the instructions in 

the Setup Utility from there.  If the paper is getting crumpled, emergency stop or pause ASAP. This 
could break very expensive parts of the machine. ASK FOR HELP if you are running into issues. 



Additional Notes
● Don’t use any media types beyond those that you have been certified to use.  Additional Media 

types are part of the Advanced Class.
● The Stewards for the BN2-20 can see all your print jobs and error history. If you run into issues, 

please own up and let the Steward know so we can check the machine. 
● You may purchase and bring your own media and laminate to save money. Please ask the steward 

for help sourcing what you need to order and setting them up to be cut. 
○ US Cutter is one source.
○ Substance is another (untested) potential source but this will require cut pressure setup and is 

reserved for the Advanced Class. 
■ https://substance.com/products/icon-pm-2750?variant=44614080790783 

● Every new type of media needs to be set up individually by the steward as the printer changes not 
just cut settings but also print settings. 

https://substance.com/products/icon-pm-2750?variant=44614080790783


BN2-20
Artwork Setup for BN2-20



Setting Up Your Own Project Files
● Design/draw your sticker graphics in whatever program you want to 

work in.  This may be an original drawing, photo, or other graphic 
done in Photoshop, GIMP, Illustrator, Corel Draw, Inkscape, or pretty 
much any other drawing program.  The actual graphics on your 
sticker can be raster or vector images.

○ When designing your sticker, think about the tightness of 
curves and corners, both inside and outside. Any that are too 
tight can be difficult to cut out well.

● If you want to automatically cut out your stickers, either with a kiss 
cut and/or die/through cut, you will need to open your art in a vector 
drawing program (if you didn’t already create your art in one) such as 
Illustrator, Inkscape or Corel Draw and add a Kiss Cut layer (spot 
color called “CutContour”) and/or Through Cut layer (spot color 
called “PerfCutContour”) to your sticker art.

● To add the Kiss Cut and Through Cut layers to your sticker, you 
create solid fill layers that are placed behind your art, and are larger 
than your graphic. This is done differently depending on the software 
you are using. 



Setting Up Your Own Project Files
● Your cut lines do not have to be larger than your sticker.  You 

can make them the same size as the artwork so they cut right 
on the line.  If you do this, you may want to add some bleed to 
your artwork to ensure there is no white outline because of a 
slight misalignment.

● These are often 0.3” larger per layer but you can work with 
sizes that suit your project.  So the pink Kiss Cut (CutContour) 
is 0.3” larger than the original art and the Through Cut layer 
(PerfCutContour) is 0.3” larger than the Kiss Cut.

● Spot Colors can be defined in Adobe Illustrator or Corel Draw.  
As of May 2026, Spot Colors are not supported by Inkscape 
and require additional programs to set correctly for the printer.  



Setting Up Your Own Project Files
To define/name Spot Colors in Illustrator

● Go to the Windows menu at the top, open the Swatches window.
● You can use a recent color or pick something entirely new.
● Double click the name of the color to change it.  Click the RGB icon on the right side of the name to 

change the color and/or the Spot Color name.



Setting Up Your Own Project Files
● The actual color you use for the CutContour and 

PerfCutContour don’t matter - only the Spot Color name 
matters. You MUST change the Color Type to Spot Color or 
they won’t work.

● Make sure that the Spot Colors are applied to the Kiss Cut 
and Through Cut shapes/layers in your file.

● Remove the outer blank space on the Artboard in Illustrator 
by selecting Object -> Artboards -> Fit to Artwork Bounds.

● Export from Illustrator to PDF and select “High Quality Print”



Setting Up Your Own Project Files
Notes:

● If you are creating inside Through Cuts, manually smooth the shape/corners to avoid tight inside 
corners that don’t cut well.

● Before exporting to PDF, you might need to change any text to a Path by using Object to Path 
(Inkscape method).  

● It is suggested to use separate layers for your art, Kiss Cut, and Through Cut.
● Might need to Path = Union for everything of similar colors before exporting.
● Suggestion is to setup your original art with one sticker at a time, not try to create a file with multiple 

stickers in one file.  You will add the quantity in Versaworks.  Saving different stickers on different 
artboards lets you do different stickers on same print run in Versaworks.

● Full image stickers really soak the material and are hard to keep flat after peeling (full color face 
sticker) so laminating may be necessary.


